


 تعالیبسمه
  

 ICDLگانه های هفتتستی مهارت سؤالاتمجموعه 

 98ویرایش اول: فروردین  - تست( 1506)
 شماره صفحه سؤالاتتعداد  مهارت ردیف

 3 211 فناوری اطلاعات مبانی و مفاهیم پایه 1

 23 252 ویندوز 2

3 Word 2007 155 48 

4 Excell 2007 570 64 

5 PowerPoint 2007 104 119 

6 Access 2007 132 128 

 141 82 اینترنت 7

   

 سایت مدیرسنتروب عزیزبا سلام و احترام خدمت شما مخاطب 

تولید  وقفه واحدبیهای حاصل تلاش (تست 1506)ICDL هفتگانه  هایمهارت تستی سؤالات مجموعه

شما  سؤالات تکتکاست و در آن سعی شده با دقت کامل پاسخ  سایت مدیرسنتروبمحتوای 

های مختلف باشد. داده شود تا بتواند ابزار مناسبی برای آزمون هفت مهارت فوقمخاطبان عزیز برای 

مختلف این مجموعه، از طریق ایمیل  هایبخشدر صورت وجود هرگونه ایراد و اشکالی در  لطفاً

 های بعدیتا در ویرایش نظرات خود را اعلام نمایید ،یگردارتباطی  هایکانالمدیرسنتر و یا هریک از 

  در انتهای هر فصل آمده است. هاتستصحیح هریک از  پاسخ ضمناً اصلاحات لازم صورت پذیرد.
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 فناوری اطلاعات( مبانی و مفاهیم پایه: )اول مهارت
 

1. Laptop شود؟محسوب می  جزء کدام دسته از کامپیوترها 

  Main Fram ب(    Super Computerالف( 

 ini Computerد(     Micro Computerج( 

 است؟. ……به  هاآن تبدیل ؛ و……دریافت  هاداده. هدف از پردازش 2

     هاب( اطلاعات، دستورالعمل    الف( اطلاعات مفید، داده

 ، واحد خروجیهادادهد(     ، اطلاعات مفیدهادادهج( 

 رود؟زیر جهت انتقال تصاویر به کامپیوتر به کار می هایدستگاهاز  یککدام .3

 د( ماوس  کلیدصفحهج(    ب( پلاتر   الف( اسکنر

 چیست؟ ریزپردازندهواحد سرعت  .4

 د( بیت در ثانیه  ج( مگاهرتز  مگابایتب(   الف( نانوثانیه

 . بهترین نوع چاپگر از نظر سرعت و کیفیت کدام است؟5

 د( حرارتی  جوهرافشانج(   ب( لیزری ایالف( ماتریس نقطه

 افزارسخت افزار ونرمروی هر سیستم که وظیفه مدیریت و کنترل و ایجاد ارتباط بین  افزارنرمترین . مهم6

 و کاربر را دارد چه نام دارد؟

 عاملسیستمد(  نویسیبرنامهج( زبان    Cpuب(  الف( برنامه مترجم

 ...واحد کنترل قسمتی است از .7

 د( واحد پردازش مرکزی  ج( حافظه  ب( واحد خروجی  الف( واحد ورودی

 شود؟های معماری یا مهندسی از کدام دستگاه استفاده میبرای چاپ نقشه .8

 د( پلاتر   ج( رسام  ب( اسکنر  الف( چاپگر

 ؟نیستدر مورد هارددیسک صحیح  یککدام .9

 توان در آن ذخیره کرد.الف( هرچه ظرفیت هارد بیشتر باشد مقدار اطلاعات بیشتری را می

 .استطولانی  هایمدتب( برای نگهداری اطلاعات با حجم زیاد و برای 

 .استو وظیفه آن نگهداری اطلاعات با حجم زیاد  استج( جزء حافظه اصلی 

 روند.گیرند با قطع جریان برق از بین نمید( اطلاعاتی که در این قسمت قرار می

 چیست؟ ROM,RAMفرق حافظه  .10

      .با دسترسی مستقیم است  RAMبا دسترسی ترتیبی و   ROM الف(

 فقط نوشتنی است. RAMفقط خواندنی است ولی  ROMب( 

        است  و نوشتنیخواندنی  RAMفقط خواندنی است ولی  ROMج( 

 با دسترسی مستقیم است.  ROMبا دسترسی ترتیبی و   RAMد( 
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 رود؟گیرد وجهت بالا بردن سرعت انتقال اطلاعات بکار میقرار می  RAMو  CPU  ای که بینحافظه .11

 د( حافظه کمکی  Romج(   Registerب(   Cacheالف( 

 شود؟های زیر با قطع جریان برق پاک میاز حافظه یککداممحتوای   .12

  EPROMد(    RAMج(   PROMب(   ROMالف( 

 گیرد؟اجرا در کدام حافظه قرار می منظوربهبرنامه  کی .13

  د( فلاپی دیسک  ج( دیسک سخت  Ramب(   Romالف( 

 رود؟که برای اتصال به اینترنت بکار می یکارت .14

 د( گرافیک   ج( صدا   ب( مودم  الف( شبکه

 چیست؟ سنجزمان. 15

 مختلف رایانه است. هایقسمتالف( نوعی گذرگاه برای تبادل داده بین 

 دارد.می  نرم و سخت را نگه گرداندیسکاز جمله مشخصات   که پیکربندی سیستم  ICب( نوعی 

 کند.ساعت سیستم را تنظیم می  ج( مدار الکترونیکی است که

 کند.مختلف رایانه، تولید می هایقسمتد( مدار الکترونیکی است که نوسانات الکترونیکی را برای هماهنگ کردن کار 

 ؟نیستهای زیر صحیح از گزینه یککدام. 16

 است. DIMMتر از حافظه بسیار سریع RIMMالف( حافظه 

 برد اصلی همخوانی داشته باشد. یهاگذرگاهحتماً باید با سرعت  DIMMب( حافظه 

 روند.به صورت زوج به کار می SIMMهای ج( حافظه

 دیگر امروزه کاربردی ندارد. DIMMد( 

پوشش یا سیم کوچکی است که برای تغییر یا تنظیم یک ویژگی در برد اصلی در نظر گرفته شده  ...  .17

 است.

 Socketد(   Slot( ج  جامپرب(   PCMCIAالف( 

کنند کدام قطعات اهمیت بیشتری استفاده می  . برای افرادی که از رایانه برای کار تخصصی گرافیکی18

 دارد؟

  Monitor-RAM-VGAب(     CPU-Monitor الف( 

 RAM-CPU-VGAد(     HARD-RAM ج( 

 ها از لحاظ محیط کار:عاملسیستم. انواع 19

 چندکاربره –ب( تک کاربره    ایچند برنامه - ایالف( یک برنامه

 وجود ندارد. عاملسیستمبرای  بندیتقسیمد( چنین     گرافیکی –ج( متنی 

 ؟نیستهای زیر از عوامل مؤثر در راندمان کار رایانه از گزینه یککدام .20

  CPUپردازش ب( قدرت     RAMالف( اندازه 

 هافایل سازییکپارچهد(     هابرنامه بندیزمانج( 

 باشند؟های کامپیوتری موجود در یک شرکت معمولاً از چه نوعی می. شبکه21
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 MANد(   PANج(   WANب(   LANالف(

  ؟نیستهای زیر جزو مزایای استفاده از شبکه از گزینه یککدام. 22

             ب( تمرکز مدیریت    هادادهالف( اشتراک پایگاه 

 عاملسیستمد( دسترسی به یک     خرابی ج( میزان تحمل

 هستند.  ...از نوع  هاو رایانه .... خطوط مخابراتی از نوع 23

                         دیجیتال –ب( آنالوگ      آنالوگ-الف( دیجیتال

 دیجیتال - دیجیتالد(      آنالوگ –ج( آنالوگ 

 های آنالوگ تلویزیونی و رادیویی را دریافت کرد.های شبکهتوان برنامهآن می لهیوسبه. کارتی است که 24

 د( کارت صدا    ج( کارت تیونر ب( کارت کپچر ویدیو الف( کارت گرافیک

 ؟نیست رایانههای زیر از عوارض استفاده نادرست از از گزینه یککدام. 25

    ناشی از کار مداومهای ب( آسیب    های ناشی از بد نشستنالف( آسیب

 های ناشی از بد تایپ کردند( آسیب نمایشصفحه ازحدبیشهای ناشی از تشعشات ج( آسیب

 ؟استهای زیر کاربرد رایانه در تجارت از گزینه یککدام. 26

      ب( سیستم پردازش حق بیمه    الف( سیستم مالیاتی

 د( آموزش از راه دور    ( سیستم هدایت آمبولانسج

 توان اطلاعات را در مقابل از بین رفتن محافظت کرد؟های زیر میاز روش یککدام. به 27

 پذیرآسیبهای افزارنرمکردن  روزبهب(      الف( تهیه پشتیبان

 د( حفظ کلمه عبور  ج( حفاظت فیزیکی از ساختمان شرکت

 گیرد.ای است که بین یک رایانه و پریز برق قرار می. وسیله28

 UBSد(    USBج(   USPب(    UPSالف( 

 ؟نیست بازمتنهای افزارنرمهای زیر جزو شروط از گزینه یککدام. 29

 د( فروش آزاد  ج( توزیع آزاد  ب( اجرای آزاد الف( انتشار تغییرات

برای یک مدت مشخص به طور آزمایشی و رایگان از آن  کنندهمصرفشود که ی گفته میافزارنرمبه   .30

 کند.استفاده می

 بازمتن افزارنرمد(   اشتراکی افزارنرمج(  نمایشی افزارنرمب(  رایگان افزارنرمالف( 

 یک کیلو بایت معادل چند بایت است؟. 31

 بایت 16د(   بایت 8ج(   بایت 1024ب(   بایت 2الف( 

 برای تایپ علائم بالای کلید کدام کلید را باید پایین نگه داشت؟ کلیددر صفحه . 32

  Alt د(  Caps lock ج(   Ctrl  ب(  Shift الف(

 چیست؟ افزارسخت. 33

 یک کامپیوتر هادستورالعملب(    لمسو قابلالف( اجزای فیزیکی 

 د( اجزای بیرونی یک کامپیوتر   ج( اجزای جانبی یک کامپیوتر
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 فناوری اطلاعات( مبانی و مفاهیم پایه: )مهارت اولپاسخنامه 
 

 پاسخ تست پاسخ تست پاسخ تست پاسخ تست پاسخ تست پاسخ تست

 ب 201 ب 161 ج 121 د 81 د 41 ج 1

 ب 202 ج 162 ج 122 د 82 ب 42 ج 2

 ج 203 الف 163 الف 123 ج 83 د 43 الف 3

 الف 204 ج 164 ج 124 الف 84 د 44 ج 4

 ج 205 الف 165 ج 125 ج 85 ج 45 ب 5

 الف 206 د 166 ج 126 ب 86 ب 46 د 6

 ب 207 د 167 ب 127 الف 87 ب 47 د 7

 ج 208 ب 168 الف 128 الف 88 الف 48 ج 8

 ب 209 ب 169 الف 129 الف 89 الف 49 ج 9

 ج 210 د 170 ج 130 الف 90 ب 50 ج 10

 ب 211 ج 171 الف 131 د 91 الف 51 الف 11

 * 212 ب 172 د 132 الف 92 ج 52 ج 12

 * 213 ب 173 الف 133 الف 93 ج 53 ب 13

 * 214 ب 174 ج 134 الف 94 د 54 ب 14

 * 215 ب 175 ج 135 د 95 د 55 ج 15

 * 216 د 176 ب 136 ب 96 ج 56 ب 16

 * 217 د 177 ب 137 ج 97 ب 57 ج 17

 * 218 ب 178 الف 138 د 98 ج 58 د 18

 * 219 الف 179 د 139 ب 99 ج 59 الف 19

 * 220 ب 180 ب 140 ب 100 ج 60 د 20

 * 221 ب 181 ب 141 ج 101 ج 61 الف 21

 * 222 الف 182 ج 142 ب 102 ب 62 ج 22

 * 223 الف 183 د 143 ب 103 الف 63 الف 23

 * 224 ج 184 ج 144 د 104 ج 64 الف 24

 * 225 الف 185 ج 145 الف 105 الف 65 د 25

 * 226 د 186 ب 146 ب 106 د 66 الف 26

 * 227 د 187 ب 147 ج 107 ب 67 الف 27

 * 228 ج 188 ج 148 د 108 ب 68 الف 28

 * 229 ج 189 الف 149 الف 109 ج 69 الف 29

 * 230 ج 190 ب 150 د 110 ج 70 ج 30

 * 231 د 191 الف 151 ج 111 ب 71 ب 31

Fr
ee

 V
er
sio

n



 

22 

 

 * 232 د 192 ج 152 ب 112 الف 72 الف 32

 * 233 ج 193 ج 153 ج 113 ج 73 الف 33

 * 234 الف 194 ج 154 ب 114 ب 74 ب 34

 * 235 ب 195 ج 155 ب 115 الف 75 د 35

 * 236 الف 196 الف 156 ج 116 ج 76 د 36

 * 237 ب 197 ب 157 ج 117 الف 77 ج 37

 * 238 د 198 الف 158 د 118 ب 78 الف 38

 * 239 د 199 الف 159 د 119 د 79 د 39

 * 240 ج 200 ج 160 د 120 ج 80 ج 40
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 (ویندوز: )مهارت دوم
 

 کند؟ها را به صورت آبشاری و روی هم مرتب میکدام گزینه پنجره .1

 Tile Windows Horizontally ب(   Tile Windows Vertically الف(

 Show Minimize AII Windows د(    Cascade Windows ج(

 شود؟شوند از چه نواری استفاده میجهت نمایش فایلهایی که به علت فضای کم پنجره دیده نمی .2

 Address Bar د(   Scroll Bar ج(   Menu Barب(   Status Bar الف(

 کدام گزینه صحیح است؟ Task Bar جهت قفل نمودن. 3

 Lock The Task Bar انتخاب ب(  Auto Hide The Task Bar انتخاب الف(

 Auto Hide The Task Bar عدم انتخاب د(   lock The Task Bar عدم انتخابج( 

 توان استفاده کرد؟برای بستن فایل جاری از کدام کلیدهای ترکیبی می. 4

 ALT+F 2د(  SHIFT+F 2ج(   ALT+F 4ب(  SHIFT+F 4الف(

 کامپیوتر درحالت استراحت قرار بگیرد چه بایدکرد؟ کهاینبرای  . 5

 کنیم.را انتخاب می Stand By گزینه Turn Off Computer از پنجره الف(

 کنیم.را انتخاب می Turn Off گزینه Turn Off Computer از پنجره ب(

 کنیم.را انتخاب می Restart گزینه Turn Off Computer از پنجره ج(

 کنیم.را انتخاب می Log Off گزینه Log Off از پنجره د(

 ها در کدام قسمت امکان پذیر است؟تنظیمات پوشه. 6

 Folder Option د( Folder Properties ج(   Tools ب(  Folder Type الف(

 شود؟ کدام گزینه استفاده می Recycle Bin از جهت بازیابی اطلاعات حذف شده . 7

 Restore د(   Empty ج(   Undeleteب(   Shift + Del الف(

 ؟گویندمیبه نوار پایین دسک تاپ چه  .8

 Status bar د(   Scrollbar ج(   Toolbaب(    Taskbar الف(

 توان استفاده کرد؟برای حذف محتویات سطل بازیافت از کدام دستور می .9

  Restore ب(    Empty Recycle binالف( 

 Format د(      Erase ج(

 شود؟ به چه منظوری استفاده می Arrange Icon By / Type گزینه . 10

 هاآنب( مرتب کردن آیکن ها براساس اندازه   هاآنالف( مرتب کردن آیکن ها براساس نام 

 د( مرتب کردن آیکن ها براساس تاریخ تایپ شده  هاآنج( مرتب کردن آیکن ها براساس نوع 

 شود.دوبار کلیک بر روی آیکن برنامه باعث چه رخدادی می . 11

              ب( بسته شدن برنامه              الف( انتخاب آیکن برنامه
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 د( اجرای برنامه         ج( باز شدن منوی میانبر 

 ؟پسوند فایل، نمایانگر چیست .12

 فایلد( حجم    ج( نام فایل  ب( اندازه فایل  الف( نوع فایل 

 کنیم.برای حذف دائمی فایلها وپوشه ها از کدام گزینه استفاده می . 13

  Recycle bin کشیدن وانداختن در ب(     Shift+DeL الف(

 Ctrl+Del د(      Delete ج(

 ؟های زیر تعریف ویروس استز گزینها یککدام .14

 شود.نوع برنامه مخرب گفته می ب( به هر شود. الف( برنامه کوچکی که مخفیانه وارد رایانه می

 شود.د( برنامه مخرب کوچکی که مخفیانه وارد رایانه می رساند.ای که به اطلاعات رایانه آسیب میج( برنامه

 شود.برای تنظیمات صفحه کاغذ از کدام دستور استفاده می .15

 Page setup د(   Print ج(   Send ب(  Print previewالف( 

 کنیم.را انتخاب می ...برای تعیین چاپگر پیش فرض گزینه  .16

  Local Printerset as ب(     Add Printerالف( 

 Set as device د(    set as default printer ج(

 ؟استساعت و تاریخ فعلی رایانه در کدام قسمت از محیط میز کار ویندوز  .17

       های در حال اجرا ب( برنامه                      الف( ناحیه تذکر 

 د( دکمه شروع            های الحاق شده ج( برنامه

 ؟کنیمازکدام کلیدهای میانبر استفاده می Task Managerبرای کار با پنجره . 18

  Ctrl+Alt+lnsert ب(     Ctrl+Alt+F 2الف(

 Ctrl+Alt+F 2د(     Ctrl+Alt+delete (ج

 arrange icons آیکن ها همیشه به طور مرتب قرار گیرند. کدام مورد را باید از منوی کهاینبرای . 19

 انتخاب نمود.

 Auto arrange د(   By type ج(   By date ب(   By nameالف( 

رایانه بیابیم، باید چه عبارتی را جست  در اگر بخواهیم دقیقاً عبارت سازمان فنی وحرفه ای کشور را .20

 وجوکنیم؟

 *حرفه ای کشور سازمان فنی و* ب(   "حرفه ای کشور سازمان فنی و" الف(

 ?حرفه ای کشور سازمان فنی و?د(     «حرفه ای کشور سازمان فنی و»ج( 

 ...جانبی( به صورتافزارنرمپسوند فایلهای فشرده شده در ویندوز )به صورت پیش فرض بدون نصب  .21

 است.

 ir د(   com ج(    zipب(    rar الف(

 ها:محلی برای نگهداری ودسته بندی فایلها و پو شه .22
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  WINDOWS EXPLORERب(     MY COMPUTER الف(

 FOLDER د(    MY DOCUMENT ج(

 شود؟برای اجرای یک برنامه از طریق آیکون آن، از کدام گزینه زیر استفاده می .23

 ازمنوی مربوطه OPEN انتخاب ب(   FORMAT ازمنوی OPEN انتخابالف( 

 هیچکدام د(   EDITاز منوی  OPEN  انتخاب ج(

ها و برگشتن به حالت قبل کدام گزینه را انتخاب برای لغو آخرین عمل انجام شده بر روی فایلها و پوشه . 24

 ؟نماییممی

 REDO د(   UNDO ج(   CLOSEب(   RESTOREالف( 

 شوند؟نگهداری میشوند در کدام محل هایی که حذف میفایل. 25

 BIOS د( RAM در حافظه موقت ج(  RECYLE BIN ب( CLIP BOARD الف(

 قرار دارد؟  PROPERTISاز سربرگهای پنجره  یککدامدر  WAITگزینه . 26

  THEMESب(     BACK GROUND الف(

 SCREENSAVER د(     APPEARANCE ج(

 های متنی، کدام است؟پسوند فایل .27

 TXT د(   PPT ج(   XLSب(    BMPالف( 

 ؟استچه  DIALOG BOX منظور از. 28

 نوار کار (د        میز کار  (ج ایکادر محاوره (ب  پنجره  (الف

توان عمل چگونه می PRINTERبرای توقف چاپ تمامی اسناد که در صف چاپ قراردارد در پنجره . 29

 نمود؟ 

 کنیم.می کلیک CANCEL بر روی گزینه DOCUMENT از منوی الف(

 کنیمکلیک می PAUSE بر روی گزینه DOCUMENT از منوی ب(

 کنیم.را کلیک می CANCEL ALL DOCUMENT گزینه PRINTER از منوی ج(

 توان این عمل را انجام دادنمی د(

 DESKTOP های روش مرتب سازی باعث نمایش یا مخفی شدن آیکن ها بر رویکدام انتخاب از گزینه. 30

 گردد؟می

  AUTO ARRANGEب(     ALIGN TO GRID الف(

 MODIFIED د(   SHOWDESKTOP ICONS ج(

 گیرد؟قرار می DESK TOP های باز رویهایی برای برنامهدر کدام ناحیه از نوار وظیفه دکمه. 31

  TOOL BAR ب(    TASK MAN GERالف( 

 SCROLL BAR د(     SYSTEM TRAY ج(

 کدام درایو، درایو منطقی است؟ .32
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 فلاپی دیسکد(   فشرده سکی( دج      هارددیسک ب(    E درایو الف(

 داریم؟برای انتخاب غیر متوالی آیکن ها کدام کلید را پایین نگه می .33

 SPACE د(   SHEFT ج(   ALT ب(   CTRLالف( 

محتوای آن را می دانیم این کلمه در کدام ای از هنگام جستجوی فایلی که کلمه SEARCH در برنامه. 34

 شود؟قسمت تایپ می

 LOOKIN ب( ALL OR PART OF THE FILE NAMEالف( 

 TYPE – MODIFIED د(    AWORD OR PHRASE IN THE FILE ج(

ها را باید از منوی برای مرتب سازی براساس نوع و تاریخ ویرایش به ترتیب از راست به چپ کدام فرمان .35

 بر انتخاب نمود؟میان

  MODIFIED –TYPE ب(     TYPE –DATE الف(

 TYPE-MODIFIED د(    DATE,MODIFIED ج(

 دهد؟کدام گزینه زیرکامپیوتر را در حالت آماده باش قرار می. 36

  Restartب(      shut down الف(

 Restart in MS-DOS mode د(      stand by ج(

 پنجره را جابه جا نمود؟توان توسط ماوس، چگونه می. 37

                 ب( باکشیدن نوار منوی پنجره    الف( با کشیدن نوارعنوان پنجره 

 د( بزرگ نمودن پنجره     ج( کوچک نمودن پنجره 

 ؟گویندمی ………به نوار رنگی بالای هر پنجره، . 38

 Task Manager د(  Quick Lanuch ج(  نوار عنوانب(    نوار ابزارالف( 

 ؟استها ها، برنامهتصاویر کوچک گرافیکی در سمت چپ محیط کار ویندوز که شامل پوشه. 39

 Icon د(   Start ج(   File ب(   Folderالف( 

 شود؟نواری که منوی کنترل روی آن قرار دارد چه نامیده می. 40

 menu bar د(   status bar ج(   title barب(    Tool barالف( 

 گردد؟های باز ویندوز، به صورت عمودی کدام روش استفاده میجهت نمایش پنجره. 41

 Tile Windows Horizontally ب(    CascadeWindows الف(

 Minimize AllWindow د(   Tile Windows Verticallyج( 

 بندد؟های زیر تغییرات را در پنجره اعمال، ولی پنجره را نمیاز دکمه یککدامانتخاب  .42

 Add د(   Cancel ج(   Applyب(    Okالف( 

 های زیر منویاز گزینه یککداممرتب نمودن فایلها از روی اندازه به ترتیب صعودی  منظوربه. 43

Arrange Icons گردد؟انتخاب می 

 Date د(   Type ج(   Sizeب(    Nameالف( 

Fr
ee

 V
er
sio

n



 

46 

 

 (ویندوز: )مهارت دومپاسخنامه 
 

 پاسخ تست پاسخ تست پاسخ تست پاسخ تست پاسخ تست پاسخ تست پاسخ تست
 ب 241 د 201 د 161 الف 121 الف 81 ج 41 ج 1

 ب 242 ج 202 ب 162 الف 122 الف 82 ب 42 ج 2

 د 243 ب 203 ب 163 د 123 ب 83 ب 43 ب 3

 د 244 ب 204 ج 164 ج 124 الف 84 د 44 ب 4

 ب 245 الف 205 د 165 د 125 ب 85 د 45 الف 5

 د 246 د 206 الف 166 ج 126 ج 86 الف 46 د 6

 ج 247 د 207 ج 167 د 127 د 87 ب 47 د 7

 د 248 د 208 ب 168 الف 128 ب 88 ج 48 الف 8

 الف 249 الف 209 ج 169 الف 129 د 89 الف 49 الف 9

 د 250 ب 210 ج 170 الف 130 ج 90 ج 50 ج 10

 ج 251 د 211 ج 171 ج 131 الف 91 ب 51 د 11

 ج 252 د 212 د 172 ب 132 ج 92 ج 52 الف 12

 * 253 الف 213 الف 173 الف 133 د 93 الف 53 الف 13

 * 254 ب 214 الف 174 الف 134 الف 94 د 54 د 14

 * 255 الف 215 الف 175 الف 135 الف 95 ب 55 د 15

 * 256 ب 216 ب 176 الف 136 د 96 ج 56 ج 16

 * 257 الف 217 ج 177 د 137 ج 97 ج 57 الف 17

 * 258 ج 218 د 178 ج 138 ب 98 ب 58 ج 18

 * 259 د 219 ب 179 ج 139 ب 99 الف 59 د 19

 * 260 ج 220 ج 180 ب 140 الف 100 الف 60 الف 20

 * 261 الف 221 ج 181 الف 141 ج 101 ب 61 ب 21

 * 262 د 222 د 182 ب 142 الف 102 د 62 د 22

 * 263 الف 223 ب 183 د 143 د 103 ج 63 ب 23

 * 264 ج 224 ب 184 الف 144 ب 104 ب 64 ج 24

 * 265 د 225 ج 185 الف 145 الف 105 ج 65 ب 25

 * 266 د 226 د 186 ج 146 د 106 ج 66 د 26

 * 267 الف 227 د 187 ج 147 ب 107 الف 67 د 27

 * 268 الف 228 ب 188 ب 148 ج 108 ب 68 ب 28

 * 269 ج 229 د 189 ب 149 ب 109 د 69 الف 29

 * 270 ج 230 ج 190 الف 150 ب 110 ب 70 ج 30

 * 271 الف 231 ب 191 ب 151 الف 111 ب 71 ج 31
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 * 272 ب 232 د 192 ج 152 د 112 د 72 الف 32

 * 273 ج 233 ب 193 الف 153 ج 113 ج 73 الف 33

 * 274 الف 234 د 194 الف 154 ج 114 د 74 ج 34

 * 275 ب 235 ج 195 د 155 د 115 ب 75 ب 35

 * 276 ب 236 ج 196 الف 156 د 116 الف 76 ج 36

 * 277 ب 237 الف 197 ج 157 ج 117 الف 77 الف 37

 * 278 الف 238 ج 198 د 158 ب 118 ج 78 الف 38

 * 279 ج 239 د 199 الف 159 ب 119 ب 79 د 39

 * 280 الف 240 ب 200 د 160 ب 120 ج 80 ب 40
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 (Word 2007) :سوممهارت 
 

 ؟چه نام دارد کلیدصفحهترین کلید بزرگ .1

 Tab(د   SpaceBar (ج   Enter (ب  Insert (الف

 ؟شودژه از کدام فرمان استفاده میبرای درج کاراکترهای وی .2

 FontSize (د   Symbol (ج   SaveAs (ب  PrintPreview(الف

 ؟تحت نام دیگری ذخیره کرد اتوان فایل موجود ربا کدام فرمان می .3

 Edit (د   Open (ج   Save (ب   SaveAs (الف

 ؟کنیماستفاده می ...از گزینه  هاآن تقسیموجهت  ...های جدول از جهت ادغام خانه .4

 Delete-Merage (د  Insert-Spilt (ج  Merage-Spilt (ب  Spilt-Merage (الف

 ؟کنیماستفاده میجهت ایجاد تورفتگی از کدام گزینه  .5

 د( الف و ج   T+Ctrl (ج  Decearse Indent (ب Incerease Indent (الف

 ؟Word به برنامه ءشی برای اضافه کردن یک. 6

 کنیماستفاده می Object زیر منوی File الف( از منوی

 کنیماستفاده می symbol زیرمنوی Insert ب( از منوی

 کنیماستفاده می Object زیرمنوی Insert ج( از منوی

 توان به برنامه ورد شئ اضافه کردد( نمی

 ؟استبهترین حالت برای نمایش صفحه ورد کدام نما  .7

 د( هیچ کدام  webLayout (ج   Outline (ب  PrintLayout (الف

استفاده  File منوی PageSetup جهت تنظیم صفحه به صورت افقی از کدام گزینه موجود در زیر منوی .8

 ؟کنیممی

 Paragraph(د  WholeDocument(ج  LandScape(ب   Portrait(الف

 ؟جهت تنظیم شاخص پرش بعد از انتخاب پاراگراف مورد نظر .9

  کنیمرا انتخاب می Insert گزینه Table الف( از منوی

 کنیمرا انتخاب می Insert گزینه Format ب( از منوی

  کنیمانتخاب میرا  Tab گزینه Table ج( از منوی

 توان تنظیمات شاخص پرش را تغییر دادد( نمی

 ؟استفاده کرد GOTO فرمان جایبهتوان از کدام کلیدهای ترکیبی می .10

 د( هیچ کدام   Ctrl+G(ج   Shift+G(ب   Alt+Gالف 

 ؟ویژه هاینوار ابزاری ست برای ترسیم اشکال، ایجاد تصاویر تفننی و ترسیم خطوط و اعمال جلوه .11

 TableBar(د   Drawing(ج  Formating(ب Standard Toolbar(الف

 ؟کنیمرا انتخاب می Insert ایم کدام زیرمنوی منویجهت درج تصویری که در کامپیوتر ذخیره کرده. 12
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 From File گزینه Picture ب( زیر منوی   ClipArt گزینه Picture الف( زیر منوی

 د( هیچ کدام   Symbol گزینه Picture ج( زیر منوی

 کنیم؟برای تغییر جهت کاغذ به صورت افقی از چه گزینه استفاده می .13

                Portraitگزینه   Orientationگروه   Page layout( سر برگ فال

 Landscapeگزینه   Orientationگروه   Insertب( سر برگ 

                            Portraitگزینه   Marginsگروه  Insertج( سر برگ 

 Landscapeگزینه  Orientationگروه  Page layoutد( سر برگ 

 کنیم؟ای استفاده میبرای درج جدول از چه گزینه .14

 Tableگروه  Insertب( سر برگ      Tableگروه  Viewالف( سر برگ 

 د( هیچکدام    Tableگروه  Page layoutج( سر برگ 

 کنیم؟ای استفاده میدرج پاورقی از چه گزینه برای .15

 Footnotesگزینه  Referencesب( سر برگ          Headerگزینه  Reviweالف( سر برگ 

 د( گزینه ب و ج    Insert Endnoteگزینه  Referencesج( سر برگ 

 کنیم؟ای استفاده میبرای اضافه کردن خط کشی به صفحه از چه گزینه .16

 Ruler  گزینه Viewب( سر برگ    Rulerگزینه  Insertالف( سر برگ 

 د( همه موارد    Ruler  گزینه Reviewج( سر برگ 

 شود؟ای استفاده میکاغذ از چه گزینه  برای تغیر اندازه .17

 Page Scapeگروه  Page layout  ب( سر برگ     Sizeگزینه  Insertالف( سر برگ 

 Sizeگزینه   PageSetupگروه  Page Layoutد( سر برگ              Sizeگزینه   Viewج( سر برگ 

 شود؟برای ذخیره یک سند تحت نامی دیگر از کدام فرمان استفاده می .18

 look in(د          save(ج        save as(ب   save in(الف

 انتخاب کنیم. ...را از سربرگ  ...برای انتخاب قلم مناسب از طریق سربرگها، باید گزینه  .19

        home \ font(ب                           insert \ font(الف

 page layout \ paragraph(د                        page layout \ font(ج

 رود؟کدام کلید ترکیبی میانبر برای کاهش سایز قلم به کار می .20

 +(ctrl(د                     +)ctrl(ج        +]ctrl(ب        +[ctrl(الف

 دهد؟چهار طرف صفحه کاغذ را به کاربر نشان می wordاز نماهای  یککدام .21

 draft(د           outline(ج         layout   web(ب    layout print(الف

 رود؟کدام فرمان برای باز کردن یک سند موجود به کار می .22

 save as(د       save(ج     open(ب          new(الف

 استفاده کرد. ...باید از کلید ترکیبی  برای رفتن به ابتدای فایل  .23

 ctrl+tab(د   ctrl+end(ج  ctrl+home(ب   ctrl+click(الف
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 تواند توسط کاربر مورد استفاده قرار گیرد؟هر الگو چند بار می .24

 هر تعداد که کاربر مایل باشد. ( بهد   بار ( سهج   ( دوبارب  کباری( الف

 کنید؟ها استفاده میبرای وارد کردن یک فایل تصویری در محیط سند، از کدام گزینه .25

 insert \ chart(د  view \ picture(ج  home \ picture(ب insert \ picture(الف

اینکه  جایبهشکل  آن وپایین نگه دارید،کل فشار داده حین درگ کردن یک شرا در ctrlچنانچه دکمه  .26

 گردد.می ...شود  ...

              کپی –به جا  ( جاب        جا به جا – ی( کپالف

 به مورد هر سه گزینه صحیح است. ( بستهد                     قرینه –جا به جا  (ج

 زبانه )ریبون( قرار دارند؟در کدام   cut, pasteهای جهت ترازبندی، تغیر فونت و گزینه .27

 view(د    review(ج    home(ب     insert(الف

 کنیم؟زبانه را انتخاب می  جهت فعال کردن خط کش کدام .28

 mailing(د            view(ج         page layout(ب      insert(الف

 کنیم؟پس از رسم جدول، جهت تنظیمات بعدی کدام زبانه را انخاب می .29

 table(د          view(ج         design(ب        home(الف

 در کدام زبانه قرار دارد؟  symbolگزینه  .30

 view(د              review(ج              home(ب             insert(الف

 شوند؟با چه پسوندی ذخیره می word 2007های محیط فایل .31

 dotx(د              docx(ج                dot(ب          doc(الف

 رسد؟کدام بخش از سند به چاپ می print whatاز لیست  odd pageبا انتخاب گزینه  .32

 آخر سند ( صفحهد  اول سند ( صفحهج    فرد ( صفحاتب  زوج ( صفحاتالف

 شود؟استفاده می ...های قابل اعمال به یک پاراگراف از برای تعیین میزان انواع تورفتگی .33

             کش قائم ( خطب           کش افقی ( خطالف

 و ج ( الفد   page layoutاز زبانه   paragraph نهی( گزج

 پیش فرض چه مقدار است؟ tabما در ن مقدار پرش مکان .34

 اینچ ( چهارد   اینچ ( دوج       اینچ می( نب      اینچ کی( الف

 توان متنی را به صورت کم رنگ در پس زمینه سند قرار داد؟از طریق کدام گزینه می .35

 water mark، دکمه   page back ground   ، گروهpage Lay out  سربرگ (الف

 water mark، دکمه page set upگروه   ، page Lay outسربرگ  (ب

 page border، دکمه page back ground      ، گروهpage Lay outسربرگ  (ج

 water mark، دکمه link، گروه insertسربرگ  (د

 توان این کار را انجام داد؟برای تنظیم حاشیه بالا و پایین سند از کدام گزینه می .36

 cover page، دکمه pages، گروه insertسربرگ  (الف
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 (Word 2007) سوم:مهارت پاسخنامه 

 
 پاسخ تست پاسخ تست پاسخ تست پاسخ تست

 د 121 ج 81 ج 41 ج 1

 د 122 ب 82 الف 42 ج 2

 الف 123 د 83 ب 43 الف 3

 ب 124 الف 84 ج 44 الف 4

 ب 125 الف 85 ب 45 الف 5

 الف 126 ج 86 ب 46 ج 6

 د 127 الف 87 د 47 الف 7

 ب 128 ج 88 ب 48 الف 8

 ب 129 ب 89 ج 49 ج 9

 ب 130 ج 90 الف 50 ج 10

 ب 131 ب 91 د 51 ج 11

 ج 132 ب 92 الف 52 ب 12

 الف 133 د 93 الف 53 د 13

 د 134 ب 94 ب 54 ب 14

 الف 135 ب 95 ج 55 ب 15

 ب 136 ج 96 ب 56 ب 16

 ج 137 ج 97 الف 57 د 17

 ج 138 د 98 ب 58 ب 18

 ج 139 ب 99 د 59 ب 19

 ج 140 د 100 د 60 الف 20

 د 141 د 101 الف 61 الف 21

 ب 142 ب 102 ب 62 ب 22

 ب 143 ب 103 ب 63 ب 23

 الف 144 د 104 د 64 د 24

 ب 145 ب 105 د 65 الف 25

 ب 146 ب 106 د 66 ب 26

 الف 147 ب 107 ب 67 ب 27

 د 148 الف 108 الف 68 ج 28

 ب 149 د 109 ب 69 ب 29

 د 150 ب 110 الف 70 الف 30

 الف 151 الف 111 ج 71 ج 31
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 د 152 د 112 ج 72 الف 32

 الف 153 ج 113 الف 73 د 33

 ب 154 الف 114 ب 74 ب 34

 ج 155 د 115 الف 75 الف 35

 * 156 ج 116 ب 76 ج 36

 * 157 د 117 د 77 الف 37

 * 158 الف 118 ب 78 ب 38

 * 159 ب 119 الف 79 ج 39

 * 160 ج 120 د 80 ب 40
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 (Excell 2007) :چهارممهارت 
 

 ؟منظور از کارپوشه چیست. 1

 ب( کارپوشه همان فولدر در ویندوز است                           الف( به فایلهای شرکت مایکروسافت گویند 

 د( کارپوشه همان کاربرگ است                            گویندمیرا کارپوشه  Excel هایج( فایل

 ؟استمعادل کدام فرمان در اکسل  Ctrl+Y دیکل .2

 Copy(د     Cut(ج    Redo(ب   Undo(الف

 ؟به چه معناست DIV/0# غامیپ .3

 های که در فرمول استفاده شده وجود ندارد الف( یکی از خانه

 کند عددی را بر صفر تقسیم کند( فرمول سعی میب

 های که در آن متن وجود دارد در فرمول استفاده شده است ج( یکی از خانه

 د( این پیغام در اکسل وجود ندارد

 از منوی Option شدن در اکسل کدام سربرگ زیرمنوی AutoFill تعیین لیست سفارشی برای جهت .4

Tools ؟شوداستفاده می 

 General(د     Edit(ج   Custom List(ب  Translation(الف

 ؟را پایین نگهداریم چه اتفاقی می افتد Ctrl کردن کلید AutoFill در هنگام اگر .5

                  دهد ب( عدد را در هر خانه یک واحد افزایش می                                                 کند الف( عدد را کپی می

 افتدد( اتفاقی نمی                     دهد ج( عدد را در هر خانه یک واحد کاهش می

 ... تغییر نام یک کاربرگ کافی ست یبرا .6

 انتخاب کنیم Renameالف( روی کاربرگ کلیک راست کرده و گزینه 

 را انتخاب کنیم Rename گزینه file ب( روی کاربرگ کلیک کرده و از منوی

 را انتخاب کنیم Rename گزینه Editج( کاربرگ را انتخاب کرده و از منوی 

 توان کاربرگ را تغییر نام دادد( نمی

 :تواند آدرس یک سلول باشدهای زیر میاز گزینه یککدام .7

 ba2د(     cadج(     b2dب(     2cالف( 

 داشته باشد؟ sheetتواند حداکثر چند می excelیک فایل  .8

 2د(      3ج(      1ب(   255الف( 

 شود؟جهت تعیین پس زمینه برای سلول جاری از کدام ابزار استفاده می .9

 more colorد(                  border colorج(                       font colorب(    fill colorالف( 

 شود؟از کدام کلید استفاده می excelبرای انتخاب چند سطر غیر همجوار در  .10

 spaceد(                                   ctrlج(                                   altب(     shiftالف( 
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 دهد؟چه عملی را انجام می mergeگزینه  .11

 د( جا دادن متن در سلول        ج( حذف قالب بندی سلول                       ب( ادغام سلول   الف( تقسیم سلول

 شود؟ها استفاده میبرای نشان دادن عدد به صورت کسر از کدام گزینه .12

 fractionد(                    accountingج(                       scientificب(     currencyالف( 

 صحیح نیست؟ sheet برای یک  نام  کدام .13

 sheet-bookد(                    sheet(book)ج                 sheet{book}ب(    sheet[book]الف( 

 شود؟برای ثابت نگه داشتن تیتر جداول از کدام دستور استفاده می. 14

 unfreezeد(                              freezeج(                               splitب (                       arrangeالف( 

 ...برای مرتب کردن اطلاعات موجود در لیست )بر اساس حروف الفبا(. 15

 home \ find (د                   insert \ sort (ج                  data \ filter (ب                  data \ sort  (الف

 نشانه چیست؟  علامت مساوی در شروع یک خانه .16

               شروع یک جستجو (ب                  شروع یک فرمول (الف

 شروع ذخیره سازی یک فایل (د         filteringشروه عملیات  (ج

 درست است؟ 2007کدام گزینه در مورد تعداد سطرهای محیط اکسل  .17

 10563د(                             23563ج(                        1048567ب(                       1048576الف( 

 کدام است؟ 2007فایلهای ایجاد شده در اکسل  پسوند .18

 XLXSد(                                 XLSج(                          XXLSب(                          XLSXالف( 

 در کدام سربرگ قرار دارد؟ Filterگزینه  .19

 Formulasد(                           Reviewج(                               Dataب(                            Viewالف( 

 کرد؟ Sum(A1:B5)/Count(A1:B5 ))  توان جایگزین فرمولکدام تابع را می .20

 AUTOSUMد(                         ROUNDج(                    AVERAGEب(                              Minالف( 

 ...برای مرتب کردن یک لیست  .21

                            کنیم.انتخاب می DATAرا از منوی  SORTالف( گزینه 

 کنیم انتخاب می DATAرا از منوی  FORMب( گزینه 

                        کنیم.انتخاب می DATAرا ازمنوی  ARRANGEج( گزینه 

 کنیمانتخاب می DATAرا از منوی  AUTOFILTERد( گزینه 

 کنیم؟را از کدام سربرگ انتخاب می Protect work bookبرای حفاظت از ساختار کارپوشه گزینه  .22

 Insertد(                  Page Layoutج(                          Reviewب(                             Viewالف( 

 کند چه نام دارد.تابعی که میانگین اعداد را محاسبه می .23

 Matد(                         Averageج(                             Countب(                              Sumالف(

 رود؟ کدام گزینه برای فریز کردن یک سطر بکار می .24

        Sort and Filter  ،freeze panes، دکمه Editingگروه   Homeالف( سربرگ 
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 filter ،freeze panes، دکمه sort and filter، گروه dataب( سربرگ 

                   filter ،freeze panes  ، دکمهsort and filter، گروه viewج( سربرگ 

 freeze panes،freeze panes، دکمه Window، گروه viewد( سربرگ 

 کند؟ کدام زبانه هم ترازی متنها را تنظیم می Homeدر سربرگ   cells Formatاز کادر محاوره  .25

 Border  د(                     Alignmentج(                               Fontب(                       Numberالف( 

 برای پنهان کردن فرمولهای کاربرگ از دید کاربر کدام مسیر درست است؟  .26

           hidden Home –Protectionب(                     Format cells-Protection- Hiddenالف( 

 د( هیچکدام                                     view-protection-Hiddenج( 

 شود؟ای استفاده میبرای حذف محتویات یک سلول از چه گزینه .27

 Clear Contentsگزینه  Homeب ( سر برگ                                    Deleteگزینه  Home الف( سربرگ 

 Clearگزینه  Clearگروه  Homeد ( سر برگ                                          Clearگزینه  Dataج ( سر برگ 

Format 

امکان اضافه کردن %  cells  formatاز کادر محاوره  numberهای موجود درزبانه از گزینه یککدام .28

 دهد؟ )درصد( را به اعداد می

 number (د                          special (ج                   percentage (ب                     currency (الف

 : Shrink To Fit گزینه  .29

            کند تا متن در آن بگنجدب( سلول را بزرگ می                                                کند الف( سلول را کوچک می

 سلول بگنجدکند تا در د( متن را کوچک می                                                       کند ج( متن را بزرگ می

 چیست؟ A10منظور از آدرس  .30

                      10و سطر  Aب( ستون                                                   Aو سطر  10االف( ستون 

 د( بستگی دارد فارسی باشد یا انگلیسی                                    توانند درست باشند ج( هر دو مورد می

 شود؟کدام گزینه برای قالب بندی شرطی استفاده می .31

                  Format Cellsب(                                       Conditional Formattingالف(

 Format as tableد(                                                                 Formatج( 

 شود؟برای گرد کردن اعداد اعشاری از کدام تابع استفاده می .32

 PMTد(                             Roundج(                                INTب(                           Countالف(

 رود؟های زیر برای ایجاد نمودار به کار میاز گزینه یککدام .33

   Insert / Graphب(                                                  Insert / Chart     الف(

 الف و ب  د(                                       Insert / Column Graphج( 

 کند که خطوط شبکه ظاهرشوندیا نشوند؟کدام تب مشخص می Chart wizardدر پنجره  .34

 titles  د(                         legend  ج(                   Gridlines  ب(                         Axes  الف(
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 (Excell 2007) چهارم:مهارت پاسخنامه 

 
 پاسخ تست پاسخ تست پاسخ تست پاسخ تست پاسخ تست پاسخ تست پاسخ تست پاسخ تست

 ج 561 ب 481 ب 401 د 321 ج 241 ج 161 د 81 ج 1

 ج 562 د 482 ج 402 ج 322 د 242 ج 162 ب 82 ب 2

 د 563 ب 483 الف 403 د 323 ب 243 الف 163 د 83 ب 3

 الف 564 الف 484 ب 404 ج 324 ب 244 د 164 الف 84 ب 4

 د 565 د 485 ب 405 الف 325 ج 245 الف 165 الف 85 ب 5

 الف 566 د 486 د 406 ج 326 الف 246 الف 166 ج 86 الف 6

 ج 567 د 487 د 407 ج 327 د 247 ج 167 د 87 د 7

 الف 568 الف 488 الف 408 ج 328 الف 248 ج 168 ب 88 الف 8

 الف 569 الف 489 ب 409 ب 329 د 249 ب 169 د 89 الف 9

 ب 570 الف 490 د 410 ب 330 ج 250 ب 170 الف 90 ج 10

 * 571 ب 491 ج 411 ب 331 الف 251 د 171 الف 91 ب 11

 * 572 د 492 ج 412 د 332 ب 252 د 172 ج 92 د 12

 * 573 ج 493 د 413 ب 333 الف 253 د 173 الف 93 الف 13

 * 574 ج 494 الف 414 ب 334 ج 254 ج 174 ب 94 ج 14

 * 575 ج 495 د 415 ج 335 الف 255 ج 175 ب 95 الف 15

 * 576 الف 496 الف 416 ب 336 ج 256 ج 176 ج 96 الف 16

 * 577 ج 497 ج 417 ب 337 ب 257 ج 177 د 97 الف 17

 * 578 د 498 ب 418 ج 338 الف 258 الف 178 ب 98 الف 18

 * 579 ج 499 الف 419 الف 339 الف 259 ج 179 ب 99 ب 19

 * 580 ب 500 د 420 د 340 ج 260 د 180 الف 100 ب 20

 * 581 ب 501 ب 421 ب 341 الف 261 ج 181 ج 101 الف 21

 * 582 ج 502 د 422 ب 342 ج 262 ج 182 الف 102 ب 22

 * 583 الف 503 الف 423 ب 343 ج 263 ج 183 الف 103 ج 23

 * 584 ج 504 ب 424 الف 344 د 264 الف 184 ج 104 د 24

 * 585 ج 505 الف 425 ب 345 د 265 ب 185 ب 105 ج 25

 * 586 الف 506 ب 426 د 346 ب 266 ج 186 د 106 الف 26

 * 587 ب 507 الف 427 الف 347 الف 267 د 187 الف 107 الف 27

 * 588 د 508 د 428 د 348 ج 268 ج 188 الف 108 ب 28

 * 589 الف 509 ج 429 الف 349 ج 269 الف 189 ج 109 ب 29

 * 590 ب 510 د 430 د 350 د 270 ال 190 د  110 ب 30

 * 591 د 511 ج 431 ج 351 د 271 ب 191 د 111 الف 31
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 * 592 د 512 ب 432 د 352 الف 272 الف 192 الف 112 ج 32

 * 593 الف 513 الف 433 ب 353 ج 273 د 193 ج 113 الف 33

 * 594 د 514 ب 434 الف 354 ب 274 ب 194 الف 114 ب 34

 * 595 الف 515 ج 435 الف 355 ب 275 ج 195 الف 115 الف 35

 * 596 الف 516 د 436 ب 356 الف 276 ج 196 ج 116 د 36

 * 597 ب 517 ب 437 د 357 د 277 الف 197 الف 117 د 37

 * 598 ب 518 ب 438 الف 358 ج 278 د 198 الف 118 ب 38

 * 599 ج 519 الف 439 ب 359 د 279 ج 199 ج 119 ب 39

 * 600 الف 520 ب 440 د 360 ج 280 ب 200 ب 120 ج 40

 * 601 د 521 الف 441 د 361 ب 281 الف 201 ب 121 ب 41

 * 602 الف 522 ج 442 الف 362 الف 282 الف 202 ج 122 الف 42

 * 603 الف 523 ج 443 د 363 ب 283 الف 203 د 123 ب 43

 * 604 د 524 الف 444 الف 364 د 284 ب 204 ج 124 ب 44

 * 605 ج 525 ج 445 الف 365 د 285 د 205 د 125 ب 45

 * 606 ب 526 ج 446 ب 366 ب 286 ج 206 الف 126 د 46

 * 607 الف 527 ج 447 ب 367 ب 287 ب 207 الف 127 الف 47

 * 608 الف 528 الف 448 ج 368 الف 288 ج 208 الف 128 ب 48

 * 609 ب 529 ب 449 الف 369 ب 289 ج 209 د 129 الف 49

 * 610 ب 530 ب 450 د 370 الف 290 ج 210 ب 130 ب 50

 * 611 ب 531 ج 451 الف 371 ج 291 د 211 ج 131 الف 51

 * 612 ب 532 ب 452 الف 372 ج 292 ج 212 ب 132 د 52

 * 613 الف 533 ج 453 د 373 الف 293 د 213 الف 133 ج 53

 * 614 الف 534 ج 454 ج 374 ب 294 ب 214 ب 134 ب 54

 * 615 د 535 ب 455 ب 375 ج 295 ج 215 ج 135 ب 55

 * 616 ج 536 الف 456 الف 376 ب 296 ب 216 ج 136 د 56

 * 617 د 537 د 457 الف 377 ب 297 ب 217 د 137 ج 57

 * 618 د 538 الف 458 ب 378 ب 298 د 218 ج 138 د 58

 * 619 الف 539 ب 459 ب 379 ج 299 الف 219 د 139 د 59

 * 620 الف 540 د 460 ب 380 ب 300 الف 220 ج 140 د 60

 * 621 د 541 ب 461 ب 381 ج 301 الف 221 ج 141 د 61

 * 622 ج 542 ج 462 الف 382 ج 302 ب 222 ج 142 د 62

 * 623 ج 543 ج 463 الف 383 ج 303 ج 223 ج 143 الف 63

 * 624 الف 544 ب 464 د 384 الف 304 ج 224 ب 144 ب 64

 * 625 ج 545 ب 465 ج 385 د 305 ب 225 ب 145 د 65

 * 626 ب 546 ب 466 ج 386 الف 306 ب 226 د 146 د 66
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 * 627 الف 547 ج 467 د 387 ب 307 ب 227 د 147 الف 67

 * 628 د 548 ب 468 الف 388 د 308 ب 228 ب 148 الف 68

 * 629 د 549 د 469 الف 389 ج 309 ج 229 الف 149 ب 69

 * 630 ب 550 ب 470 د 390 د 310 الف 230 الف 150 ب 70

 * 631 ب 551 د 471 ج 391 ج 311 ب 231 ج 151 د 71

 * 632 ب 552 د 472 ج 392 ب 312 ب 232 الف 152 د 72

 * 633 ج 553 ب 473 الف 393 ب 313 ب 233 ج 153 الف 73

 * 634 الف 554 د 474 ج 394 د 314 الف 234 ب 154 د 74

 * 635 ب 555 ب 475 ب 395 ج 315 الف 235 ب 155 ج 75

 * 636 ب 556 ج 476 الف 396 ج 316 الف 236 د 156 الف 76

 * 637 د 557 الف 477 د 397 ب 317 ج 237 د 157 ج 77

 * 638 الف 558 د 478 د 398 د 318 د 238 ج 158 الف 78

 * 639 ب 559 ج 479 ب 399 د 319 الف 239 ب 159 ب 79

 * 640 د 560 ج 480 ب 400 د 320 الف 240 ج 160 ب 80
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 (PowerPoint 2007) :پنجممهارت 
 

 ؟توان مشاهده کردفضا را میچند  Normal نمای در .1

 د( همه موارد   SpeakerNotes(ج   Slide(ب   Outline(الف

 ؟کنیماستفاده می ...از کلید  هاآنبرای گسترش دادن  ؛ وجمع کردن اسلایدها کلید ... یبرا .2

  Expand-Callapse(ب    Callapse-Expand(الف

 د( هیچ کدام     Expand-Filter(ج

 ؟افزودن یک آرم یبرا .3

 کنیمرا انتخاب می ClipArt گزینه Picture زیر منوی Insert الف( از منوی

 کنیمرا انتخاب می Fromfile گزینه Picture زیر منوی Insert ب( از منوی

 کنیمرا انتخاب می FromFile گزینه Object زیر منوی Insert ج( از منوی

 د( الف و ج

 ؟استپاورپوینت چه  افزارنرمها در فایل پسوند .4

 ppt(د     dc(ج    wrd(ب    asl(الف

 ؟گویندمیهای تولیدی توسط پاورپوینت چه فایل به .5

 Persentaion(د    Book(ج   Plaint(ب  Document(الف

 ؟استدن الگوی ایجاد شده کدام مورد صحیح رفعال ک یبرا .6

 Format>Apply Design Template( ب    Format>Apply Format( الف

 د( هیچ کدام    Insert>ApplyDesign( ج

 ؟شودکدام گزینه برای افکت دادن به زمینه استفاده می از .7

 Format>Background>fillcolor>Gardient( ب   Format>Background>Effcet( الف

 د( هیچ کدام   Insert>Background>Effect( ج

 شود؟کدام گزینه برای افزودن جدول به اسلاید استفاده می از .8

  Insert / Table ب( گزینه    Insert / New Slide الف( گزینه

 توان به اسلاید اضافه کردد( جدول را نمی     Insert /Diagram ج( گزینه

 رودمی اسلاید عنوان بکار اضافه کردن فقط  برای  Slide Layout  گزینه درقسمت کدام .9

  Title And Text (ب     Title Slide (الف

 Title Only (د    Title And Content (ج

 توان ازالگوهای از قبل آماده شده برنامه نمایش ایجاد کرد؟کدام روش می با .10

  From Design Template         (ب    Blank Presentation (الف

 New Presentation  (د   From Auto Content Wizard  (ج

 کنیم؟از طریق کدام منو عمل می Slide Layout برای دسترسی به پنجره .11
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 Edit  (د   Tools (ج   Insert (ب   Format (الف

 .گویند ...باشندهایی جهت درج متن و تصویر میخالی که شامل محل یدهایاسلا .12

 Blank Slide (د  Slide Outline (ج  Slide Master( ب  Slide Layout (الف

 توان استفاده نمود؟کدام گزینه برای درج تصاویر درون کامپیوتر در اسلاید می از .13

 From File (د   Word Art (ج    Insert File (ب      Clipart (الف

 آید؟کدام گزینه از روشهای نمایش اسلاید بشمار می .14

 View (د   Note Page (ج    Existing (ب  Template (الف

 کدام شیوه نمایش اسلایدها به راحتی قابل حذف و اضافه و انتقال هستند؟ در .15

 د( هیچکدام  View Slide (ج  Slide Sorter (ب   Slide Show (الف

شکل ظاهری لیستهای نشانه دار اسلایدها از قبیل فونت،  توان می Slide Master کدام قسمت از در .16

 را تغییر داد؟ ...اندازه فونت و

 Master Text Style (ب     Master Title Style (الف

 Second Level (د     Third Level (ج

 توان جهت حرکت موضوع را تعیین کردمی Custom Animation قسمت از کادر کدام  در .17

 Path (د   Start (ج   Speed (ب  With Previous (الف

 رود؟های زیر برای اضافه کردن اسلاید جدید به کار میاز گزینه یککدام .18

  Alt+s (د    Ctrl + I (ج   Ctrl + M (ب   Ctrl + N (الف

 توان متن یا تصویر به اسلاید اضافه نمود؟کدام نما نمی در .19

 Outline (د    Normal (ج  Slide Sorter (ب  Note Page (الف

 :انتخاب شدهبرای حذف اسلاید  .20

  Delete Slide  گزینه Edit ب( از منوی   Delete Slide گزینه File الف( از منوی

 Delete Slide  گزینه Format د( از منوی     Delete Slide گزینه View ج( از منوی

 .توان یک کپی از اسلاید را بعد از همان اسلاید ایجاد کردفشار کدام کلیدها می با .21

 Ctrl + D (د      Ctrl + V (ج   Ctrl + X (ب   Ctrl + C (الف

 شود اجرا می فقط اسلاید جاری  با انتخاب کدام دکمه  Slide Transition کادر در .22

 Automatically After (د  Slide Show (ج   Play (ب  Apply To Slide (الف

کدام گزینه زیر زمان تأخیر برای حرکت ،   Timingو در سربرگ   Custom Animationکادر  در .23

 توان وارد کرد؟موضوع را می

 Repeat (د   Speed (ج   Delay (ب   Start (الف

 شودکل اسلایدها در کدام نوار نمایش داده می تعداد .24

 د( نوار ابزار  ج( نوار منو  ب( نوار عنوان  الف( نوار وضعیت 

 ؟است ...فایل ارائه مطلبترین بلوک ساختمانی یک یاساس .25
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 (PowerPoint 2007) پنجم:مهارت پاسخنامه 

 
 پاسخ تست پاسخ تست پاسخ تست

 د 81 الف 41 د 1

 الف 82 ب 42 ب 2

 ب 83 ب 43 د 3

 ب 84 الف 44 د 4

 ب 85 د 45 د 5

 الف 86 ج 46 ب 6

 ج 87 الف 47 الف 7

 الف 88 ب 48 ب 8

 ب 89 ب 49 د 9

 ب 90 الف 50 ب 10

 الف 91 الف 51 الف 11

 ج 92 ب 52 الف 12

 د 93 ب 53 د 13

 ج 94 ب 54 ج 14

 ج 95 ج 55 ب 15

 د 96 ب 56 ب 16

 ب 97 الف 57 د 17

 د 98 الف 58 ب 18

 الف 99 ج 59 ب 19

 ب 100 ب 60 ب 20

 د 101 د 61 د 21

 ج 102 ب 62 ب 22

 الف 103 د 63 ب 23

 ب 104 ج 64 الف 24

 * 105 ج 65 د 25

 * 106 الف 66 ب 26

 * 107 ج 67 ج 27

 * 108 ب 68 د 28

 * 109 الف 69 ج 29

 * 110 ج 70 ب 30

 * 111 الف 71 الف 31
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 * 112 الف 72 د 32

 * 113 الف 73 الف 33

 * 114 د 74 ج 34

 * 115 ب 75 ج 35

 * 116 ب 76 الف 36

 * 117 ب 77 ب 37

 * 118 الف 78 الف 38

 * 119 ب 79 د 39

 * 120 د 80 ج 40
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 (Access 2007) :ششممهارت 
 

 ؟کنندمیعمل  یبر چه مبنا هافرم .1

 ها( جدولد  ها  ( مدولج  ( ماکروهاب  ( صفحاتالف

 ؟خاص بعد از انتخاب آن یوردکچاپ ر جهت .2

 کنیممینت را انتخاب ینه پریگز file یالف( از منو

 کنیممیانتخاب  را Selected Record نهینت گزیپر یر منویز file یب ( از منو

 کنیممی انتخاب Page نهینت گزیپر یر منویز file یج( از منو

 کنیممیانتخاب  All نهینت گزیپر یر منویز file ید( از منو

 ؟کندمیمرتب  یلدها را بصورت نزولینه فیگز کدام .3

  setAsceding(ب     Sort Descending(الف

 و ب ( الفد       Sort(ج

 ؟خ و ساعتیردن تارکاضافه  جهت .4

 Date/Time یر منویز Object یمنو ( ازب   Date/time یر منویفرمت ز یالف( از منو

 دامک ( هیچد  date/time نهیگز new یر منویفرمت ز یمنو ( ازج

 ؟ح استیدام مورد صحکار یمع عنوانبه ----- یکردن کره یذخ جهت .5

 مینکرا انتخاب  save As Filter نهید و گزینک یکلک Filter By Form مهکد ( رویالف

 کنیممیانتخاب  save As Queryگزینه د و ینک یکلک Filter By Form مهکد یو ( رب

 ردک یار معرفیمع عنوانبهرا  ----- یک توان( نمیج

 و ب ( الفد

 ؟شوندمیبا چه قالبی ذخیره  Access هایفایل .6

                             BMPب(                         DOCXالف( 

 PPTXد(                                 accdbج(

 ؟کنیممیاز چه گزینه استفاده  هاجدولبرای ایجاد یکپارچگی ارتباط بین  .7

 Relationگروه  Creatب( سر برگ   Data Typeگروه  Data Sheetبرگ سر الف(

 د( گزینه الف و ج Relation  ships گروه Data Sheet برگ ج( سر

 ؟شودمیاستفاده  ایگزینهس و جو از چه پربرای ایجاد یک  .8

 Formگروه  Creatب( سر برگ     Tableگروه  Creatالف( سر برگ 

 Reportsگروه  Creatد( سر برگ     Other گروه Creat ج( سر برگ

 نسبت داد؟ Currencyچه مقداری را باید به نوع داده  .9

 د( پولی  ج( تاریخ و ساعت  ب( عددی  الف( متنی

 باید انجام داد؟ کاریچهبرای اینکه فیلدی را از نوع کلید اصلی تعریف کنیم  .10
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 Primary key  گزینهالف( راست کلیک روی فیلد مورد نظر و انتخاب 

 Designاز سر برگ  Primary Keyب( انتخاب فیلد مورد نظر و انتخاب گزینه 

                        Createاز سر برگ  Primary Keyج( انتخاب گزینه 

 د( گزینه الف و ب

 نام دارد. ...یک موضوع   دربارهاز اطلاعات  ایمجموعه .11

 بانک اطلاعاتی (د   فیلد (ج   رکورد (ب  جدول (الف

 هستید. ...ایجاد ارتباط بین جداول بانک اطلاعاتی نیازمند  یبرا .12

 هیچکدام (د  یک فیلد کد (ج یک فیلد مشترک (ب یک فیلد کلید (الف

 ؟نیست accessگزینه از اجزای بانک اطلاعاتی  کدام .13

 filter (د   report (ج   table (ب   form (الف

 ؟شودمیکدام نوع کنترل برای انتخاب فقط یک حالت از بین چندین حالت استفاده  از .14

 text  box (د     label (ج combo  box (ب  check  box (الف

 مربوط به جزئیات داخل هر فرم یا گزارش چه نام دارد؟ بخش .15

 design(د   detail (ج   footer (ب       header (الف

 ؟شودمیدر نظر گرفتن نام توصیفی برای فیلدها از کدام مشخصه استفاده  یبرا .16

 input mask (د  new  value(ج      caption (ب  default value (الف

 اینترنتی را نگهداری کرد؟ هایآدرس توانمیاز انواع فیلدها  یککدام در .17

 currency (د     hyper link (ج  ole  object (ب  lookup  wizard (الف

 دارای چه پسوندی است؟ accessبانک اطلاعاتی  لیفا .18

 ldb (د     idx (ج   accdt (ب        accdb (الف

 ؟استگزینه از حالتهای نمایش فرم  کدام .19

 همه موارد (د   data  sheet (ج  form  wizard (ب    design (الف

 ؟شودمیاستفاده  ...گزینه  ...ایجاد ارتباط بین دو جدول از سربرگ  یبرا .20

        relation ships گزینه   data base tools ( سربرگالف

   relation shipsگزینه  homeسربرگ  (ب

                                            formگزینه  createسربرگ  (ج

 tableگزینه  createسربرگ  (د

 ؟شوندمیبانک اطلاعاتی باچه پسوندی ذخیره  .21

 هیچکدام (د     accessdb (ج   accb (ب   accdb(الف

 تهیه کرد؟  یک پرس و جو توانمیاستفاده از کدام گزینه   با .22

                macro (د        report (ج         quary (ب          table (الف

 گزینه راهی برای ایجاد یک گزارش است؟ کدام .23
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 سه گزینه ( هرد  report wizard(ج   blank report (ب  design report (الف

 را در جدول وارد کرد؟ هادادهبدون تعریف فیلد  توانمیکدام حالت  در .24

 wizard table(د  design view (ج datasheet view (ب       table (الف

 ؟کنیممیخاصیت استفاده   تعریف یک عنوان برای فیلدها از کدام یبرا .25

 field size (د  format (ج   caption (ب  name (الف

یک فیلد از طرف سیستم پیغام اخطار   بخواهیم جدول را طوری تنظیم کنیم که با خالی رها کردن اگر .26

 ؟کنیممیظاهر شود از کدام مشخصه استفاده 

 هیچکدام (د  required (ج   caption (ب     format(الف

 ؟کنیممیتبدیل یک فایل اکسس به به محیط اکسل کدام زبانه را انتخاب  جهت .27

 database (د           design (ج      external (ب        creat (الف

 ؟کنیممیتعیین نوع آدرس کدام مشخصه را انتخاب  یبرا .28

 الف و ب (د    auto number(ج         text (ب            memo (الف

 ؟کنیممیفیلد در بین فیلدها کدام زبانه را انتخاب   اضافه کردن یک جهت .29

 home (د          creat (ج        design (ب      insert (الف

 ؟کنیممیانتخاب کلید اولیه کدام زبانه را انتخاب  جهت .30

 design (د     insert(ج     home (ب     creat (الف

 ؟رودمیبرای ساختن یک جدول کدام گزینه زیر بکار  .31

 Table Design  ، دکمه table، گروه  Homeسربرگ  (الف

 Table Design  ، دکمه  Table، گروه  Create  سربرگ (ب

       Table Design  ، دکمه  Table، گروه database Tools  سربرگ (ج

 گزینه الف و ب (د

 باید کرد؟ کاریچهبرای تبدیل یک فیلد به فیلد کلیدی  .32

 .کنیممیرا انتخاب   primary keyروی فیلد راست کلیک کرده، گزینه  (الف

 primary key، دکمه  Tools گروه ، Design  سربرگ انتخاب فیلد، (ب

            keyprimary، دکمه  Tools، گروه Home  سربرگ انتخاب فیلد، (ج

 الف و ب (د

 برای شماره تلفن و مبلع به ریال چه فرمتی مناسب است؟ .33

 number ،Text (ب   number  ،           number (الف

 text  ،Currency (د                              text   ،numberü (ج

 ایجاد کرد؟  یک پرس و جو توانمیچه طریقی  از .34

 New Query، زیر گزینه Query Wizard  ، دکمه other، گروه Createسربرگ  (الف

 New Query، زیر گزینه Query Wizard  ، دکمه Tools   ، گروهDesignسربرگ  (ب
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            New Query، زیر گزینه Query Wizard  ، دکمهfont  گروه ،  Home   سربرگ (ج

 الف و ج (د

 ؟شودمیایجاد جدول و یا فرم و گزارش در بانک اطلاعاتی از کدام سربرگ استفاده  یبرا .35

                            Create ب(                            Home  الف(

 Data haseToolsد(                   ExternalDataج( 

 باز کردن یک بانک اطلاعاتی چه مراحلی راباید طی کرد؟ یبرا .36

  Openو سپس  Homeسر برگ  ( رویب         Open  الف ( روی دکمه آفیس و گزینه

 د( هر سه مورد    Openو سپس  Createج( روی سربرگ 

 ؟شویدمیاز کدام گزینه وارد  Access 2007برای اعمال ریاضی در  .37

 Createازسربرگ   Totals ( گزینهالف

                                                           ExternalData   ازسربرگ  Totals نهیگز(ب

          Data Sheetاز سربرگ    Totals ج( گزینه

 Home از سر برگ  Totals د( گزینه

 .شودمیایجادگزارش ازکدام گزینه استفاده  یبرا .38

 Reportsد(                          Queriesج(                            Tablesب(                          Macroالف(

 .شودمیتولد ازچه نوعی معرفی  خیلدتاریف .39

    Yeslnoد(                   Data &timeج(                             Memoب(                              Textالف(

 .شودمیارتباط بین جدول ازکدام گزینه استفاده  یبرا .40

 Maerdد(                            Starlupج(                        Analyzeب(            Relation Shipsالف(

 .استهای اکسس چه  لیپسوندفا .41

 Docxد(                                 Xlstج(                                 Docب(                           Mdbxالف(

 ؟استچه  Access2007فرمت فایلهای  .42

 xlsد(                             mdbxج(                                mdbب(                               xlsxالف(

  ؟کنیممیبرای ایجاد فیلد کلیدی چه مسیری را انتخاب  .43

 Design→show/hide→indexب(                               Design→tools→primary keyالف(

 Design→show/hideد(                                                        Design→builderج(

 ؟کنیممیرا انتخاب  ایگزینهچه  createبرای ایجاد جدول به روش طراحی از سربرگ  .44

 Tables→table templatesب(                                                         Tables→tableالف( 

 موارد ( همهد                                              Tables→table designج(

را انتخاب  ایگزینهچه  Database tools→show/hideمسیر برای ارتباط یک به چند بین جداول از  .45

 ؟کنیممی

 Relation shipsد(                              creatج(                           Ltomeب(                       Designالف( 
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 (Access 2007) ششم:مهارت پاسخنامه 

 
 پاسخ تست پاسخ تست پاسخ تست پاسخ تست

 الف 121 ب 81 الف 41 الف 1

 الف 122 ج 82 ج 42 ب 2

 ب 123 د 83 الف 43 الف 3

 الف 124 د 84 ج 44 الف 4

 ب 125 ب 85 د 45 ب 5

 ج 126 الف 86 ب 46 ج 6

 ج 127 الف 87 الف 47 ج 7

 ج 128 ب 88 د 48 ج 8

 د 129 د 89 د 49 د 9

 ج 130 ج 90 ب 50 د 10

 ج 131 ج 91 الف 51 ب 11

 د 132 الف 92 ب 52 الف 12

 * 133 د 93 ب 53 د 13

 * 134 ج 94 ب 54 ب 14

 * 135 ب 95 ب 55 ج 15

 * 136 د 96 د 56 ب 16

 * 137 د 97 ج 57 ج 17

 * 138 الف 98 د 58 الف 18

 * 139 ب 99 الف 59 ج 19

 * 140 ب 100 الف 60 الف 20

 * 141 د 101 ب 61 الف 21

 * 142 الف 102 الف 62 ب 22

 * 143 الف 103 ج 63 د 23

 * 144 الف 104 د 64 ب 24

 * 145 د 105 الف 65 ب 25

 * 146 د 106 الف 66 ج 26

 * 147 ج 107 ب 67 ب 27

 * 148 ج 108 الف 68 الف 28

 * 149 د 109 د 69 ب 29

 * 150 ب 110 الف 70 ج 30

 * 151 الف 111 ب 71 ب 31

Fr
ee

 V
er
sio

n



 

140 

 

 * 152 د 112 ب 72 د 32

 * 153 الف 113 الف 73 د 33

 * 154 الف 114 ب 74 الف 34

 * 155 د 115 ب 75 ب 35

 * 156 د 116 ب 76 الف 36

 * 157 د 117 الف 77 د 37

 * 158 د 118 ب 78 د 38

 * 159 ب 119 الف 79 ج 39

 * 160 ب 120 د 80 الف 40
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 (اینترنت) هفتم:مهارت 
 

 های ارائه دهنده خدمات اینترنت چه نام دارد؟شرکت .1

 Mcp د(   Aol ج(    Ispب(    Icp الف(

 ؟گویندمی ...صفحه خانگی یک وب سایت را  .2

 Current page د(  Web page  ج(  Home Page ب(  First Page الف(

 شود؟های ارسال شده در کدام پوشه نگهداری مینامه .3

 Inbox د(   Outbox  ج(   Trashب(    Draft الف(

اند برای اینکه بدون اتصال به شبکه بتوانیم از صفحاتی که قبلاً در زمان اتصال به شبکه استفاده شده .4

 کنیم؟می استفاده نمود از کدام گزینه استفاده

 Option د(  Work Offline  ج(   Favorites ب(   History الف(

  نام دیگر آدرس وب سایت چیست؟ . 5

 URL د(   RLU ج(    IDب(    ISPالف( 

6 .E – Mail به چند دریافت کننده بطوریکه سایر دریافت کنندگان از وجود هم مطلع نشوند،  برای ارسال

 باید درکدام قسمت نوشت؟ 

 Subject د(   TO  ج(   BCC ب(   CC الف(

7 .domain در آدرس E-mail  نشانه چیست؟ 

 ب( نام سرویس دهنده پست الکترونیکی      الف( نام کاربر

 د( نام فایل مورد نظر    ج( صفحه جهانی گستر وب

   توان یک آدرس ایمیل را از آدرس وب سایت تشخیص داد؟چگونه می .8

               ب( عدم وجود نوع سرویس دهنده            @الف( وجود علامت 

 د( وجود علامت /                            ج( نام سرور 

 ؟استکدام گزینه یک موتور جستجوگر  .9

 TVTO د(   find ج(   Google ب(   searchالف( 

 شود؟برای مشاهده ومرور صفحات وب از کدام برنامه زیر استفاده می .10

  Windows Explorerب(     Internet Explorer الف(

 microsoft Outlook د(     Outlook Express ج(

  ای که به ما رسیده باید بر روی کدام دکمه کلیک کنیم؟برای پاسخ به نامه .11

 New د(   Forward ج(   Reply ب(   sendالف( 

 استفاده نمود. ...توان از+ در کنار کلمات می جایبههنگام جستجو در موتور جستجو گر  .12

 " "(د   OR ج(   AND ب(   NOT الف(
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 (اینترنت) هفتم:مهارت پاسخنامه 

 

 پاسخ تست پاسخ تست پاسخ تست
 ب 81 ج 41 الف 1

 الف 82 ج 42 ب 2

 * 83 الف 43 ج 3

 * 84 الف 44 ج 4

 * 85 ب 45 د 5

 * 86 ب 46 ب 6

 * 87 الف 47 ب 7

 * 88 الف 48 الف 8

 * 89 ب 49 ب 9

 * 90 ب 50 الف 10

 * 91 الف 51 ب 11

 * 92 د 52 ب 12

 * 93 ب 53 الف 13

 * 94 ج 54 ب 14

 * 95 د 55 ب 15

 * 96 ج 56 ب 16

 * 97 الف 57 ب 17

 * 98 ب 58 ج 18

 * 99 الف 59 ج 19

 * 100 الف 60 ج 20

 * 101 ج 61 د 21

 * 102 ج 62 الف 22

 * 103 ج 63 ب 23

 * 104 ب 64 الف 24

 * 105 الف 65 د 25

 * 106 الف 66 الف 26

 * 107 ج 67 ب 27

 * 108 الف 68 ب 28

 * 109 د 69 ب 29

 * 110 ب 70 د 30

 * 111 ب 71 ج 31
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